
MidWavi Pro Help

 
· What is MidWavi Pro

· The Audio CD Player

· The Sound and Video Player (AU - AVI – DAT – MED - MID – MOV - MPEG (MP2 & MP3) – MPG - 
WAV)

· The Graphics Viewer (BMP - FIF - ICO - JPG - WMF) – The Clipboard

· The Tools Menu including Default all settings

· Status Checking (background polling)

· MidWavi Pro Play & Display Lists

· Registration details



What is MidWavi Pro

MidWavi Pro (so called because it can play Mid, Wav and Avi files) is a full 32 bit multimedia program 
capable of:

· Playing audio CD’s (programmable)

· Playing sound files (AU - MED - MPEG Layer 2 & 3, MID & WAV)

· Displaying Full Screen video (AVI, MOV and MPEG including VideoCD)

· Displaying and printing various graphic files (BMP, FIF, ICO, JPG and WMF)

· Playing CD tracks or sound files whilst displaying a slide show of graphics (Play & Display)

· Combing full screen loop or random play and display, the ultimate screen saver with sound

· Creating and playing custom Play/Display Lists – see MidWavi Pro Play & Display Lists.

Please read the FAQ (Frequently Asked Questions) text file if you have any problems running MED sound
and MPEG or MOV video.

MidWavi Pro will only run on Windows 95, Windows 98 or NT 4.

Please be sure to read the FAQ text file for full details on possible sound and video playback 
problems, and all users (Win 95-98-NT4) should note that for MPEG and MOV sound and video to 
work with MidWavi Pro 2.70 and on, you must have IE5 (Internet Explorer Version 5.x or later) 
installed on your system (i.e. Media Player Version 6.x or later). It should also work with IE4, but 
this has not been tested.

If you do not care to use IE5 (or IE4), you should stay with version 2.60 of MidWavi Pro BUT please
be aware that there are now known problems with 2.60 (and earlier) regarding MPEG sound files 
that have a very low sample rate.

This version requires only two external libraries (DECO_32.DLL and MEDPDLL.DLL) and is thus very 
easy to install/uninstall.

As of version 2.58 on, this process is fully automated by the installation routine (Setup.Exe), but you 
should read Install.Txt for additional information regarding uninstalling.

MidWavi Pro comprises:

MidWavi.Exe
MidWavi.Hlp
DECO_32.DLL
MEDPDLL.DLL

these being the program itself,    its library for FIF graphics and MED sound file support together with the 
help file. Some text files are also provided (FAQ, Install, ReadMe, WhatsNew, MidWavi Pro Play Lists, 
MED play details etc. etc.).

There will also be assorted files that are required for the uninstalling process (see Install.Txt).



In addition, you should always keep the file REGISTER.EXE (its only about 126K) in the same directory 
as MidWavi Pro as this is used for registration (or upgrading) purposes. MidWavi Pro itself though makes 
no use of this file (apart from the registration routine).

All of the above files will be installed into your MidWavi Pro sub directory and if you didn’t stipulate one, 
the default location is:

“Program Files\TSoft Ltd\MidWavi Pro\”.

An extremely powerful search option is available to you for finding sound, video and graphic files 
(including searching CD drives and mapped network drives). See Search Drive.

Coupled with the search option is the ability to create custom Play/Display Lists. See MidWavi Pro Play & 
Display Lists  .  

The audio CD player can be programmed to play up to thirty tracks in a variety of ways, and up to 99 
tracks can be played in all.

MidWavi Pro assumes you have a working sound card and CD drive (MidWavi Pro will not run at 
all if no CD drive is detected) and is suitable only for Windows 95/98 and Windows NT 4.

In addition, MidWavi Pro will not run if it detects that Windows 95/98 or NT 4 has been set-up to 
use 'Large Fonts'. If this is the case, and you wish to run MidWavi Pro, you must go to 'Display 
Properties' then the 'Settings' tab and change the 'Font Size' setting from 'Large Fonts' to 'Small 
Fonts'.

 (Hint: the quickest way to get to the 'Display Properties' window is to single right mouse click ON 
THE DESKTOP and take the 'Properties' option).

Not all sound and video files are created equal (particularly video files) so if any problems are 
experienced, try running the same file with the Media Player (version 6.x or later) provided with Windows 
95/98/NT 4 - if the problem persists, you may have found a rouge file!

It is strongly recommended that you turn “Auto insert notification”/"Auto Play" OFF. This will prevent the 
CD player supplied with Windows 95/98/NT 4 from starting up every time you insert an audio CD (for 
details on how to achieve this, click this… Turning auto play off)

Only one instance of MidWavi Pro can be run (indeed, if MidWavi Pro detects itself, or another 
program is already using the CD drive when MidWavi Pro is launched, the most recently launched copy of
MidWavi Pro will offer a message, then close down).

Currently, supported formats are:

Video: AVI, MOV and MPEG (*.mpg and *.dat)

Graphics: BMP, FIF, ICO, JPG and WMF.

Sound: AU, MED, MID, MPEG (Layer 2 & 3 - *.mp2 and *.mp3) and WAV

Please read the FAQ (Frequently Asked Questions) text file if you have any problems running MED sound
and MPEG or MOV video. 

Be sure to visit the MidWavi Pro Web Site (www.midwavi.com) on a regular basis where you will 
always find the latest version available for download.



For queries concerning MidWavi Pro contact:

Terry Simpson
TSoft Ltd

Tel. +44 (0)1933-355629
Email: support@midwavi.com

Web Site: www.midwavi.com or www.midwavi.co.uk



Audio CD Player

Audio CD

It is strongly recommended that you turn “Auto insert notification” OFF. This will prevent the CD player 
supplied with Windows 95/98 from starting up every time you insert an audio CD (for details on how to 
achieve this, click this… Turning auto play off)

If you must retain ‘Auto insert notification’, be aware that to use MidWavi Pro after inserting an audio CD, 
you will first have to Stop and Exit the Windows CD Player (which of course will have automatically 
kicked-in when you inserted the audio CD).

Audio CD Features

· You can program up to thirty tracks as follows:

· Play In the order in which tracks are selected – ‘Select’

· Play randomly – ‘Random’

· Play Sequentially (one after the other) – ‘Play’

· You can play up to 99 tracks (one at a time in ‘Single Play’ mode, or randomly)

· Track time details (whilst playing) can be displayed in incrementing (‘Elapsed time’) or 
decrementing (‘Remaining time’) mode (i.e. you can see how much time of a track has already 
been played or is left remaining)

· Total selected track times (‘Tracks Selected Time’) can be displayed (useful for dubbing a CD to
a cassette tape)

· You can opt for a standard CD player (‘Normal CD Player’) to minimize use of system resources

· Control of a CD including: Play, Stop, Pause, Next, Previous and Eject (Next and Previous 
also work in ‘Random’ and ‘Select’ modes)

· CD details of total playing time and total number of tracks are displayed

· Updated track details can be displayed (or not) in the MidWavi Pro icon on the Task Bar – 
‘Update Icon whilst maximised’

· A Tools Menu (including control over Status Checking) giving further options and controls

· Multiple CD drives supported (you can nominate which CD drive plays an audio CD)

· You can "cue" a CD track to within one second of desired play by way of a slider

· Intro(duction) scan button to allow all selected tracks to be previewed (user definable)

Playing an Audio CD

Loading an audio CD ready for playing:
If your system has more than one CD drive, you will be presented with a drop-down list box of all the 



available CD drive letters. Click on the one you require to select it (this selection is "remembered" the next
time you run MidWavi Pro).

You will be prompted to place an Audio CD in your CD drive, then click the ‘Load’ button.

If you place a data (rather than an Audio) CD in the drive and try to ‘Load’ it, a message will appear 
alerting you to the situation and offering to eject the CD.

The CD control buttons ‘Play’, ‘Stop’ etc. etc.    work exactly as you would expect them to work, so I’ll 
not insult your intelligence by providing help on these!

However, please be aware that certain actions will, of necessity, ‘turn off’ other actions… e.g. if you 
‘Stop’ a CD whilst in ‘Random’ play mode, random play is turned off.
 
Playing all tracks sequentially:
If you simply wish to play all tracks sequentially (one after the other) click the ‘All’ button then the ‘Play’ 
button (MidWavi Pro will have selected all tracks by default when it first reads the CD disk so in this case 
you merely click ‘Play’).

Playing selected tracks sequentially:
To select a custom choice of tracks to play sequentially, click the ‘None’ button and then click the 
checkboxes corresponding to the tracks you wish to play (e.g. to hear tracks 3,5 and 10 only, click the 
checkboxes adjacent to tracks 3,5 and 10 then click the ‘Play’ button).

Tip: if you wish to hear all tracks except (say) 9, click the ‘All’ button then un-check the checkbox next to 
track 9 (i.e. click in the checkbox so that it is no longer ticked).

Playing tracks randomly:
To play the CD tracks randomly (and forever, well until you stop the program), click the ‘Random’ 
checkbox – play will commence automatically (each time you click this checkbox off/on a new random 
selection is made).

If you align the mouse cursor over the ‘Random’ checkbox, you may click the right mouse button for a 
display of the currently selected random tracks (see also ‘Tools Menu’).

Playing tracks in the order selected:
If you wish to play tracks in a particular order (say track 7 first followed by track 3 etc.), click the ‘Select’ 
checkbox and click the track checkboxes in the order that you wish to hear them then click the ‘Play’ 
button.

If you align the mouse cursor over the ‘Select’ checkbox, you may click the right mouse button for a 
display of the current order of track selection (see also ‘Tools Menu’).

Playing a single track:
If you wish to play a single track (up to track 99) click the button next to the button marked ‘None’.

This button starts out as being called ‘Single’ but once a CD has been loaded (using the ‘Load’ button), 
the title of this button will change to reflect the number of tracks on the CD e.g. if there are 12 tracks on 
the CD, this button will become ‘1 to 12’ etc.

Note that the 1 in ‘1 to 12’ will be underlined meaning that you can access this option with the keyboard 
as per normal Windows conventions (Alt 1).

Single track playing is really only intended for playing tracks above track 30 thus giving you a mechanism 
for going beyond the programmable limit (i.e. you have a total of 30 checkboxes – tracks - to program).



Once you have made your track selection (using either keyboard entry or the spin buttons – see more 
below), you may hit the ‘Enter’ key or click ‘Play Track’ to continue (‘Cancel’ to abort).

Spin buttons are the lazy way of entering detail (in this case a track number).

The spin buttons are next to the box containing the track number – each click of the upper spin button will 
add one to the current number displayed or each click of the lower spin button will subtract one from the 
current number displayed.

Tip: keep the left mouse button held down for a rapid ‘spin’ (up or down).

As with keyboard entry, the spin buttons are programmed not to go beyond the track limits of the current 
CD (i.e. if the CD has 12 tracks, you cannot ‘spin’ beyond 12). Obviously, you can never go below 1.

Tracks Selected Time:
If you wish to determine the total playing time of all the tracks you have selected click the ‘Tracks’ button.

This will give you an hours/minutes display that can be useful for such things as dubbing a CD to cassette
tape etc. (copyright laws permitting or course!).

Intro:
The ‘Intro’ button allows you to play (preview) every SELECTED track (in ‘Random’ mode, forever).

The default setting is to play the first ten seconds of each track, but you can vary this anywhere between 
1 and 120 seconds (see ‘Set Intro Play Time’ on the ‘Tools’ menu or single right mouse click on this 
button).

Your custom setting will remain throughout the session but note that the default (ten seconds) is applied 
every time you run MidWavi Pro.

This button toggles ON/OFF and its caption will change to reflect its current state (i.e. when ON the button
is called ‘Intro On’ and when off, ‘Intro Off’).

To use:
1. Select the desired tracks in the normal way (or simply take the ‘All’ option)
1. Toggle the ‘Intro’ button ON by clicking on it (or use Alt+I on the keyboard)
1. Click 'Play' (the '‘Next’ & '‘Previous’' buttons are also active).

You can toggle this button ON/OFF at will (even whilst playing tracks) so for example, if you hear the 
introduction to a track that you would like to listen to, toggle the button to OFF before ten seconds (or 
whatever your setting is) of the track has been played and the track will continue to play.

An indication of your chosen Intro time selection is shown in red at the top left hand corner of the CD 
decrementing/incrementing time display box.

That is, if Intro is ON then the information is shown whereas if Intro is OFF it is not.

If the red time indication is on display, you may left mouse click anywhere in the red timer numbers to 
bring up the "Set Introduction Time" screen (i.e. same as single right mouse clicking on the Intro ON/OFF 
option in the ‘Tools’ menu).

Elapsed time:
Click on this radio button for an updating display of the amount of time the track has been playing.

Remaining time:



Click on this radio button for an updating display of the amount of track time remaining.

You may toggle between ‘Elapsed time’ and ‘Remaining time’ whilst a track is playing and the display will
adjust to reflect the current setting.

Normal CD Player
If you wish to have almost no Status Checking whilst playing an audio CD (and therefore no feedback 
information from the CD), you have an option called ‘Normal CD Player’.

The purpose of ‘Normal CD Player’ is to enable you to play a CD with minimal capabilities (but also 
minimal use of your system resources).

You might use this (for example) to play an audio CD whilst being on-line to the Internet etc. etc.

Update Icon whilst maximised
When you minimise MidWavi Pro say, to make room on your display for other items, the CD track details 
will always be updated on the resulting icon in the Windows task bar.

This option, when turned on (ticked), also allows you to see track details (updating) on the icon in the 
Windows task bar but when MidWavi Pro is maximised.

If this option is turn off (not ticked) then the Windows task bar icon will display various status messages 
relating to the state of the CD (e.g. ‘CD playing’ etc.) when MidWavi Pro is maximised.

Slide control for cueing a CD track
You can cue (position) a CD track by use of the slide control (immediately below the updating track time 
display).

Using the mouse:
Left mouse button single click and hold down the "thumb" (pointer) in the slide control. When you do this,
the track will stop playing.

Keeping the mouse button held down, drag the "thumb" left (to move towards the beginning of the 
track) or right (to move towards the end of the track).

Keep an eye on the updating track time display which will change as you are dragging the thumb 
(pointer).

You can position the required play starting point to within one second.

When you are at the desired point, release the left mouse button.

Then, click on the button called Cont (i.e. Continue).

The track will commence play at the exact spot that you selected.

Using the keyboard.
Tab to the slider control (or click anyway on it) so that it has the "focus".

Use the left arrow (cursor) key to move towards the beginning of the track.

Use the right arrow (cursor) key to move towards the end of the track.

(Note that you can keep these keys held down to continually move)



Use the PgUp (Page Up) key to go straight to the beginning of a track.

Use the PgDn (Page Down) key to go straight to the end of a track.

Note, once you hit any of the above keys, and the slider control has the focus, the track will stop playing.

Keep an eye on the updating track time display which will change as you press these keys.

You can position the required play starting point to within one second.

When you are at the desired point, release the arrow key(s) and hit the Tab key which should move you 
to the button called Cont (i.e. Continue). Press <ENTER> or <Space Bar>.

The track will commence play at the exact spot that you selected.

Graphics:
This button will take you to the MidWavi Pro Graphics Viewer.

Providing you are playing your selections when you hit this button, you will be offered the chance to leave 
your audio CD selections playing (i.e. you can listen to your selected CD Tracks whilst viewing graphics – 
“Play & Display”).

NB…you must be already playing your audio CD selection(s) in order for this option to be offered.

Please bear in mind that some systems may not take too kindly to playing audio CD Tracks whilst trying to
display graphics or search drives etc. (you will just have to try it on your system and see how it goes).

Also note that MidWavi Pro will prevent you from attempting to play audio CD simultaneously with
MID and/or WAV sound files.



Tools Menu

Tools Menu Options

System Status:
Clicking ‘System Status’ will display details of your computers RAM and hard drive (i.e. swap file) space 
as well as CPU clock speed and type. Click the ‘Refresh’ button to update the display (the details of 
which can be constantly changing).

Tool Tips:
Clicking ‘Turn Tool Tips On’ – ‘Turn Tool Tips Off’ will enable/disable the displaying of Tool Tips 
(miniature Help boxes that popup when you move the cursor over a control e.g. when the cursor is over 
(say) the ‘Random’ checkbox control, help will popup for this control).

Default all settings:
All settings are returned to their original ‘Default all settings’.

Set Status Checking (CD Player):
See separate help for Status Checking

Turn reminder OFF/ON (CD Player):
When MidWavi Pro starts up, you can opt for a message box that details current settings for Status 
Checking and random play (e.g. if MidWavi Pro is about to start in random play mode, this reminder box 
will inform you that this is so).

The default is ON but you can turn this feature OFF (and then back ON if you wish) with this option.

You can also toggle this option OFF in the message box itself by ensuring that the checkbox ‘Display 
this every time MidWavi Pro is run’ is NOT ticked.

Display Random Tracks (CD Player):
Use this option to display the list of tracks randomly selected by the computer when you have taken the 
‘Random’ option (see Audio CD Player). Remember that every time you take the ‘Random’ option, a 
new list is generated.

Also, if you align the mouse cursor over the ‘Random’ checkbox, you may click the right mouse button 
for a display of the currently selected random tracks. This will yield the same result as the above.

Display “As Selected” Tracks (CD Player):
Use this option to display the list of tracks as selected by you having taken the ‘Select’ option (see Audio 
CD Player). 

Also, if you align the mouse cursor over the ‘Select’ checkbox, you may click the right mouse button for a
display of the current order of track selection. This will yield the same result as the above.

Play List/Display List ON/OFF
See MidWavi Pro Play & Display Lists

Set Intro Play Time:
Use this option to set the amount of time (in seconds) that each track will play for when ‘Intro On’ has 
been enabled. You may set this anywhere between 1 and 120 seconds. You can also get to this option 
(when relevant) by clicking on the red time indicator in the minuets/seconds box of the Audio CD Player.

The default is for ten seconds.



You can also get to this option by single right mouse clicking on the ‘Intro On/Off’ button.

Your custom setting will remain throughout the session but note that the default (ten seconds) is applied 
every time you run MidWavi Pro.

You can exit this option by hitting the Esc key.

Volume Control   –   Ctrl V:  
Assuming you have it installed on your system, you can call up the Windows master volume control ("Play
Control") from the "Tools" menu on the Audio CD, Sound & Video and Graphics Viewer modules (or by 
keying "Ctrl+V" - that's hold down the Control key whilst keying V or v).

Please note that in any module, if the "Tools" menu is unavailable, providing the source has the focus 
(e.g. in Graphics Viewer "TV Look", force the focus onto a graphic by clicking anywhere within the 
graphic), you can still invoke the volume control by using the keyboard shortcut (Ctrl+V).

But, there is one "gotcha"...Because of possible screen corruption; in Full Screen Video mode, you cannot
call up the Volume Control or the Slider Control whilst a video is Paused.

Enter Registration Keys:
This is where you will enter your Registration Keys when you have purchased MidWavi Pro.

Upon entry of keys, your copy of MidWavi Pro will become both personalized and fully functional.

Run OctaMED:
Use this option to run OctaMED from within MidWavi Pro. When you exit OctaMED, you will be returned 
to MidWavi Pro.

If OctaMED is not installed on your system, a suitable message is posted.

Configure MED playing:
Use this option to set various MED play options.

As a rule of thumb, you can normally ignore these settings, but read MED for further details.

Run highlighted file with Windows Media Player   –   Ctrl+W:  
Sound & Video Player...You can run the Windows Media Player on any highlighted file in the File List 
Box.
 
Also, the above option is offered if an error occurs whilst trying to play or display sound and video files.

In addition, you can call up this option with the keystrokes Ctrl+W (that's whilst holding down the Control 
key, hit the W or w key).

Please note that MidWavi Pro expects to find version 6.x of the Windows Media Player, if not, a 
suitable error message is posted.

The main reason for adding this functionality is because of the ever-increasing trend for file types not to 
be what they appear to be (e.g. MPEG video files masquerading as AVI files etc.).

The main reason for adding this functionality is because of the ever-increasing trend for file types not to 
be what they appear to be (e.g. MPEG video files masquerading as AVI files etc.).

MidWavi Pro does its best to play and display all types supported, but it does rely on the file name 
extension being accurate (e.g. an AVI is expected to end .AVI etc.) and by adding this new option, 



because the Windows Media Player is more tolerant in this respect, a greater degree of flexibility has 
been achieved.

So what this all means is that if MidWavi Pro refuses to play or display a file, you can immediately try to 
see if the Windows Media Player will work with the file.



Default Settings

Default all settings:
When you make changes to any of the settings listed below, these changes are preserved by MidWavi 
Pro for use next time (e.g. if you change the slide show delay to 2 seconds, this will be the setting the 
next time you run MidWavi Pro).

The purpose of this option is to return MidWavi Pro to its original ‘factory’ settings.

The following settings will take immediate effect when the ‘Default all settings’ option is taken from the 
‘Tools Menu’. These settings are also preserved for use the next time MidWavi Pro is run.

Tool Tips (default OFF, but ON the very first time MidWavi Pro is run)
Font colour (default Blue – if you have created a custom colour, it will be lost)
Font Bold: (default ON)
Font minimum size (default OFF)
Font size: (default 10)
Track time display (default Decrementing)
Video display (default “Resize”)
Update Taskbar icon (default, display track times on Taskbar Icon when running maximised)
Random:Play mode (default OFF)
Polling (default Normal)
Display Reminder (default OFF, but ON the very first time MidWavi Pro is run)
Slide Show delay (default 4 seconds)

Obviously, the above will over-ride any settings that you may have made so be aware that you will forfeit 
any such custom settings if the ‘Default all settings’ option is taken.

‘Check for CD Ejection whilst playing’ defaults to ON when MidWavi Pro is first run, but you can turn 
this OFF and the setting will be preserved (see Status Checking - Check for CD Ejection whilst playing). 
In other words, ‘Check for CD Ejection whilst playing’ is unaffected by ‘Default all settings’.

Other settings are, under suitable prompting, on a “per session” basis.



Turning Auto Play Off

To stop Windows 95/98 from automatically playing an audio CD when placed in the CD drive, do the 
following…

· Double click on the desktop icon called ‘My Computer’ (or find the group containing the icon ‘Control 
Panel’).

· Double click on the icon called ‘Control Panel’.

· Double click on the icon called ‘System’.

· Click the tab called ‘Device Manager’

· Click the plus sign (‘+’) next to the entry ‘CD ROM’ to open up a list of your CD drives (normally, just 
one drive will be shown here).

· Double click on the drive description (if more than one drive is installed, double click on the one that 
you wish to change).

· Click on the ‘Settings’ tab.

· Find the setting called ‘Auto insert notification’ and make sure that it is NOT ticked (checked).

· Repeat the last three steps for any other CD drives you have installed.

Windows NT 4 users need to go to the "View" option in Control Panel and take the "File Types" tab. In 
here, you will see a setting "Audio CD" which when you double click will have the word "Play" in bold 
type. Click on "Set as default" to toggle this OFF/ON (i.e. when OFF, the word "Play" is not in bold type). 
This only affects audio CD's on an NT 4 machine.

A side benefit from doing this is that your system will no longer be continually ‘polling’ your CD drive(s) 
and you might find the whole system a bit more responsive.

The down side is that if you are used to Windows 95/98 automatically starting up CD menus etc. (e.g. 
magazine cover disks), you will no longer have this functionality (NT 4 will still have this functionality).

If you must retain ‘Auto insert notification’/'Auto Play', be aware that to use MidWavi Pro after inserting an
audio CD, you will first have to Stop and Exit the Windows CD Player (which of course will have 
automatically kicked-in when you inserted the audio CD).



Status Checking

Status Checking only applies to the MidWavi Pro Audio CD Player.

If your system works smoothly (as should be the case) when running MidWavi Pro, the only things
you need to read below are Check for CD Ejection whilst playing and Normal CD Player

Background Polling
MidWavi Pro functionality such as displaying track times, knowing if you have removed a CD disk etc. 
relies on the system continually "polling" (interrogating) the CD drive.

Although normally not the case, on some systems this can cause your machine to become sluggish.

If this is the case, go to the ‘Tools’ menu option and select ‘Set status checking’.

The numeric options presented are delays per second in between polling, and so the higher the number 
you set, the more responsive your system will be (but at the expense of MidWavi Pro performance)

As an example of how the settings can degrade MidWavi Pro, consider the following…

· At its default setting (‘Normal’), MidWavi Pro will update track details every second.
· At a setting of (say) 10, track details will only be updated every 10 seconds.

Clearly, for MidWavi Pro, the best setting is ‘Normal’.

You will be offered the chance to either change a setting temporarily or preserve the change for use as 
the default every time MidWavi Pro is run.

If you wish to check the current status setting you may either visit this option and view the screen or 
single right mouse click anywhere on the MidWavi Pro Audio CD Player window (suggest bottom right 
hand corner).

Check for CD Ejection whilst playing
Obviously, it is good practice to stop a CD before you eject it, but the setting ' Check for CD Ejection 
whilst playing ' will, if turned ON (checkbox is ticked), inform you if you remove (eject) a CD whilst it is 
still playing.

This option defaults to ON when MidWavi Pro is first run, but the preferred choice is to keep this 
turned OFF, i.e. do not have the checkbox ticked – you are not in the habit of removing CD’s whilst they 
are playing are you?

If you do opt for ' Check for CD Ejection whilst playing ' OFF as suggested but you do remove a CD 
whilst it is still playing, hit the ‘Stop’ button and MidWavi Pro will automatically adjust itself to the 
situation.

Normal CD Player
This option is a checkbox on the main audio CD player screen (see Audio CD Player), but also impacts 
on system resources.

If you wish to have almost no status checking whilst playing an audio CD (and therefore no feedback 
information from the CD), you have an option called ‘Normal CD Player’.

The purpose of ‘Normal CD Player’ is to enable you to play a CD with minimal capabilities (but also 
minimal use of your system resources).



You might use this (for example) to play an audio CD whilst being on-line to the Internet etc. etc.



Sound and Video Player

Select Sound & Video   –   Select Play List (AU-AVI-MED-MID-MPEG-WAV):  

Note that this button can be toggled between Select Sound & Video and Select Play List by single right 
mouse clicking anywhere on the button.

For Select Play List see MidWavi Pro Play Lists.

Select Sound & Video

Before you can play sounds or videos (see Playing Selected Sound & Video Files) you must first select 
the files you wish to play.

This option allows you to pilot around your drive(s) using a normal Windows drive/directory box.

Once you have found the required drive/directory destination containing your sound and/or video files, 
you may then select them as follows:

MidWavi Pro supports so called ‘extended selection’ (a standard Windows protocol) and this means that 
you can either select

· a single file by single left clicking on it

· a group of sequential files by single left clicking the first required then going to the last 
required and, whilst holding down the ‘Shift’ key, single left clicking on it thus selecting 
all the files in between clicks

· a list of selected files by holding down the ‘Control’ key whilst single left clicking on the 
required file and then moving on to the next required file and doing the same until all 
required files have been selected

Hint: for fast selection of all files, click anywhere in the file list box, then hit Ctl + A on the keyboard (that’s
hold the Ctl key down and at the same time hold the A key down)

You can select approximately 600 files in this manner, but they all have to reside in the same directory
(for a powerful alternative to this, be sure to read Search Drive).
.
It is perfectly acceptable (indeed, it is a feature of MidWavi Pro) to mix file types so that for instance your 
selection may contain a mixture of AU, AVI, MED, MID, MPEG, MOV and WAV files.

It should be noted that the default search pattern is for all AU, AVI, MED, MID, MPEG (sound and video), 
MOV and WAV files but you can change this.

If you click the down arrow in the box called ‘Files of type’ in the drive/directory box, you will be offered 
the choice of finding AU only, AVI only, MED only, MID only, MPEG (for sound - *.mp2 & *.mp3, for video 
*.mpg) only, MOV only or WAV only files.

In addition, if you wish to play a VideoCD movie, you should select the *.dat option from the ‘Files 
of type’ drop down list and “pilot” yourself to the required directory on the CD.

Please note that whilst you are also free to enter a file search pattern in the box called ‘File name’, there 
is no point in so doing because the only playable file types are already covered (AU, AVI, MED, MID, 
MPEG, MOV and WAV).



If you do enter an illegal search pattern (for example, *.EXE) and then go on to select and try to ‘play’ any
found, MidWavi Pro will advise that it cannot ‘play’ such a file. (You will also receive this message if 
MidWavi Pro cannot play MPEG or MOV sound/video – see the FAQ text file for details).

Once you have completed your selection, click ‘Open’ to continue (or ‘Cancel’ to abort).

If you select too many (or indeed no) files, a suitable error message is provided.

Assuming no errors are reported you will now have a file list box containing your selection ready to be 
played.

Now see Playing Selected Sound & Video Files.

See also Search Drive.

See also MidWavi Pro Play Lists
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Graphics Viewer

Select Files For Display:
Before you can display graphics (see Displaying Selected Graphic Files) you must first select the files you
wish to display.

Note that this button can be toggled between Select Files For Display and Select Display List by single 
right mouse clicking anywhere on the button.

For Select Display List see MidWavi Pro Play Lists.

This option allows you to pilot around your drive(s) using a normal Windows drive/directory box.

Once you have found the required drive/directory destination containing your graphic files, you may then 
select them as follows:

MidWavi Pro supports so called ‘extended selection’ (a standard Windows protocol) and this means that 
you can either select

· a single file by single left clicking on it

· a group of sequential files by single left clicking the first required then going to the last 
required and, whilst holding down the ‘Shift’ key, single left clicking on it thus selecting 
all the files in between clicks

· a list of selected files by holding down the ‘Control’ key whilst single left clicking on the 
required file and then moving on to the next required file and doing the same until all 
required files have been selected

Hint: for fast selection of all files, click anywhere in the file list box, then hit Ctl + A on the keyboard (that’s
hold the Ctl key down and at the same time hold the A key down)

You can select approximately 600 files in this manner, but they all have to reside in the same directory
(for a powerful alternative to this, be sure to read Search Drive).
.
It is perfectly acceptable (indeed, it is a feature of MidWavi Pro) to mix file types so that for instance your 
selection may contain a mixture of BMP, FIF, ICO, JPG and WMF files.

It should be noted that the default search pattern is for all BMP, FIF, ICO, JPG and WMF files but you can 
change this.

If you click the down arrow in the box called ‘Files of type’ in the drive/directory box, you will be offered 
the choice of finding BMP only, FIF only, ICO only, JPG only or WMF only files.

Please note that whilst you are also free to enter a file search pattern in the box called ‘File name’, there 
is no point in so doing because the only playable file types are already covered (BMP, FIF, ICO, JPG and 
WMF).

If you do enter an illegal search pattern (for example, *.EXE) and then go on to select and try to ‘display’ 
any found, MidWavi Pro will advise that it cannot ‘display’ such a file.

Once you have completed your selection, click ‘Open’ to continue (or ‘Cancel’ to abort).

If you select too many (or indeed no) files, a suitable error message is provided.



Assuming no errors are reported you will now have a file list box containing your selection ready to be 
displayed.

Please note that the first time you enter ‘Graphics Viewer’ mode, only the control buttons are visible (i.e.
there is no file list box, no slide show delay control and no font size/colour control).

All possible/relevant controls are made visible/usable once your first file selection has been made.

Now see Displaying Selected Graphic Files.

See also Search Drive.
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Playing Selected Sound & Video Files

Playing Selected Sound And Video Files

For playing Play Lists, see MidWavi Pro Play Lists.

Once you have selected your files (see Sound and Video Player - Select Sound & Video), you will have a 
list of them in the MidWavi Pro file list box.

A feature called sub selection (a kind of secondary file selection option) is now available to you.

Once you have made your initial selection (i.e. the file list box has been populated), you will notice that 
every single file name now has its own checkbox beside it (they will all be ticked when first selected). See 
also 'Sub Select'.

This means that by clicking in the checkbox area of the file name, you can toggle that individual 
selection ON/OFF (i.e. ticked/checked - not ticked/unchecked).

Let us say that your initial selection produced ten file names. If you were to then uncheck file names that 
appeared in the order 2, 4, 8 and 10 and then opted for 'Auto Play', file names 1,3,5,6,7 and 9 only will 
be displayed/played.

You may now either:

· Highlight a file name (single left click), then double left click it to play that file

· Click the ‘Play’ button to play the currently highlighted file

· Click the checkbox ‘Auto Play’ so that it is ticked (checked) and all the selected files will be 
automatically played in sequence from the highlighted file on (MidWavi Pro defaults to this 
mode on startup, but you have to click ‘Play’ first)

At any time (in any of the above modes) you may click the ‘Next’ or ‘Previous’ buttons to move forwards
or backwards through the file list.

You may also take any of the above actions whilst a file is playing (e.g. if you are playing the first file in a 
list, you may highlight (say) the sixth file and double click that. The effect will be to stop playing the 
current file and start playing the sixth etc.).

MidWavi Pro also offers "dragging" of a AU, MED, WAV, MID, MPEG, MOV or AVI play position. What this
means is that you can "slide" a "thumb" left or right whilst a sound or video is playing to affect the current 
playing position and see the effect in real time as the minutes and seconds change to reflect the new 
position within the file.

With some practice, you can position to within a second or two of your desired playing position. This is 
definitely one of those options that you need to "play" with to see the benefits.

You can also run endless Loop and Random sound-video shows (the ultimate screen saver!). 

Random Play mode:

Either single right mouse click ‘Play’ or take "Random ON/OFF" options from the ‘Tools’ menu.

Please be aware of the following limitations:



MidWavi Pro supports up to 24,000 filenames when using the powerful "Disk Search" option.
 
The maximum filenames for random play/display is 24,000 (which is the maximum allowed anyway).

Random mode will play "for ever" (well, click ‘Stop’ to end it).

MidWavi Pro will always start up in "Random Play OFF" mode but any "toggles" (changes of mode) will 
remain on a per session basis unless MidWavi Pro senses bad logic (i.e. trying to play one file 
randomly!!!).

Endless Loop (in sequential order):

You can also run a continuous sound and video show (i.e. your chosen sound and video files can be 
played/displayed repeatedly such that when the last one in a selection is played/displayed the cycle 
begins again at the first).

You get to this feature from the ‘Tools’ menu or by single right mouse clicking the ‘Auto Play’ checkbox -
this toggles between ‘Auto Play’ and ‘Loop Play’.

The ‘Tools’ menu option ‘Loop Play OFF’ toggles to ‘Loop Play ON (Esc or Stop to end)’ and back 
each time you click on it.

Clearly, with ‘Loop Play ON (Esc or Stop to end)’ set (or ‘Loop Play’), you have your endless sound 
and video show.

Use the checkbox ‘Auto/Loop Play’ as an indicator of the mode you are in.

MidWavi Pro will always start up in ‘Loop Play OFF’ mode but any "toggles" (changes of mode) will 
remain on a per session basis.

As may be apparent, if you combine the sound and graphics loops, you could have a screen saver 
playing your selected pictures (full screen) and sounds endlessly (and/or randomly).

MidWavi Pro now "learns" about “bad” sounds and video clips it cannot load, and self deletes the 
offending file(s). Note, this does not mean it actually deletes the file(s), it merely unchecks (unticks) them 
from the ListBox. This should mean that when running in Slide-Loop-Random, you will only see a 
message once saying "Problem loading xxxx filename" etc.

Sub Select
This button will yield a small box offering the chance to filter your original selections even further.

Let us say that you have taken the 'Search Drive' option (which will automatically select all files for 
playing) but you only wish to play AVI and MID files. If you click the checkboxes marked AVI and MID, 
your selections will automatically be made for you from the original list meaning that only these file types 
will be selected for playing from the list.

Also, you will notice a number beside each checkbox that signifies how many of that type were found (i.e. 
if there were 30 *.AVI files found then the number 30 will be next to the AVI checkbox etc. etc.).

This box is also automatically displayed after a ‘Search Drive’ option is completed so that you can see 
the outcome of the search.

Search Result
This option allows you to search through the list of files that you, or search drive, have selected.



The search will always commence at the currently highlighted filename.

You can isolate the search to the filename only part of the full pathname by prefixing your search with the 
asterisk (*) character.

Suppose you want to know if you have a sound or video file with (say) the word "tiger" (without the 
speech marks of course) in it, then your search pattern will be *tiger. 

If you want to see if there are any more "tiger" files, take this option again, and the last item searched for 
will be offered as the default to search for again (you can of course overtype this for a new search).

If a match is found, the file will be automatically highlighted for you ready for play.

An example:

If you wished to locate only filenames containing the characters (say) "bear" (without the speech marks of
course), you would enter *bear as your search pattern.

If you leave out the * character, the entire pathname is searched meaning that any directories (Folders) 
containing "bear" would also be returned.

Be aware that the search will always commence from the currently highlighted filename forwards, so 
keep this in mind if you are near the end of a list.

A message box will popup if there are no (or no more) matches for the search.

Tip: The quickest way to go to the top of a file list is to click anyway in the list, then hit the 'Home' key.

Tip: The quickest way to go to the bottom of a file list is to click anyway in the list, then hit the 'End' key.

Keyboard selection:
Ensure that the file list box has the focus (i.e. that this is the area of your screen where input is accepted).
You do this by either left clicking anywhere in the file list box or hitting the ‘Tab’ key until a dotted line 
appears around the currently highlighted file name.

Use of the ‘Home’ and ‘End’ keys is supported to pilot yourself to the top of a file list (‘Home’) or bottom 
of a file list (‘End’). You may also use the up/down cursor keys to pilot around the file list. 

Once the desired file name is highlighted, you can hit the ‘Enter’ key to commence playing.

File size, date and time and full path and file name details:
To obtain byte size and date details of the currently highlighted or playing file, you may single right click 
either anywhere in the file list box area or anywhere on the MidWavi Pro window (suggest bottom right 
corner).

Also, the complete path and filename is displayed.

This includes video clips but bear in mind that, depending on the video display mode, the file list box my 
be obscured by the playing video clip so in effect you will be right clicking on the video.

If no file time is shown, this means the file was created at midnight (00:00:00).

If you have a Play List (see MidWavi Pro Play Lists) in operation, its name will also be displayed.

If a MED is playing (or loaded), the MED description, if any,    (as opposed to its filename) will be 
displayed.



Video

You have three options for displaying video as follows:

Resize:
If this radio button is set (clicked), the video will play in its own window at its original size.

In this mode, you may ‘grab’ the edges of the window and re-size it (using the usual Windows method 
with left mouse button held down etc.). This is quite a severe test of your video system, so results will 
vary. Also, you can expect an enlarged video to go ‘blocky’.

In some situations, this will mean that you can no longer see the MidWavi Pro controls.

To control such a video, click on the MidWavi Pro window (or, if the MidWavi Pro window is completely 
obscured, bring it up from the task bar) and then click the relevant button (‘Stop’, ’Next’ etc.).

Resize to fit:
If this radio button is set (the default), the video will play contained within what was the file list box area of 
the MidWavi Pro window.

The video will be stretched (or reduced) to fit and all controls are available.

Full Screen:
In this mode, the video will expand to fill the screen. Obviously, some systems will cope better than others
in this mode, you’ll just have to try it and see but it can be said that super smooth full screen MPEG, MOV
and AVI is possible.

In Full Screen video mode, you can "single right mouse" click to bring up a popup menu that 
offers Next-Previous-Pause-Stop-File Detail-Slider etc. See Slide control for cueing a sound or video 
file for details on the “Slider” control. The ‘Slider’ option also offers ‘Pause’ - ‘Stop’ - ‘Next’ - 
‘Previous’ as well as file size and duration information.

Also, whilst in Full Screen Video mode, apart from the popup menu "Slider" option, you can invoke the 
"Slider" by keying "Ctrl+S" - that's hold down the Control key whilst keying S or s.

But, there is one "gotcha"...Because of possible screen corruption; you cannot call up the Volume Control 
or the Slider Control whilst a video is Paused.

Elapsed time:
Click on this radio button for an updating display of the amount of time the file has been playing.

Remaining time:
Click on this radio button for an updating display of the amount of file time remaining.

You may toggle between ‘Elapsed time’ and ‘Remaining time’ whilst a file is playing and the display will 
adjust to reflect the current setting.

Slide control for cueing a sound or video file
You can cue (position) a sound or video file by use of the slide control (immediately below the updating 
file play time display).

Using the mouse:
Left mouse button single click and hold down the "thumb" (pointer) in the slide control.



Keeping the mouse button held down, drag the "thumb" left (to move towards the beginning of the file) 
or right (to move towards the end of the file).

Keep an eye on the updating file play time display which will change as you are dragging the thumb 
(pointer).

When you are at the desired point, release the left mouse button.

The file will commence play at the exact spot that you selected.

Using the keyboard:
For very fine adjustment of video playback, you can use the cursor keys (up, down, left and right) to 
"move" the video forwards/backwards, and the "Home" and "End" keys to go to the beginning and end of 
the video.

You must make sure that the slider has the focus (by either tabbing to it or clicking on it) before you use 
the keyboard (and must respond quickly as the slider continually loses the focus - its meant too).

Auto Play:
If this checkbox is ticked, you can produce an automatic play/display of all your selected sound and video 
files. When single right mouse clicked, this toggles between ‘Auto Play’ and ‘Loop Play’ (see above for 
details on Loop Play).

Graphics:
This button will take you to the MidWavi Pro Graphics Viewer.

Providing you are playing your selections when you hit this button, you will be offered the chance to leave 
your selections playing (i.e. you can listen to your sound files whilst viewing graphics – “Play & Display”).

NB…you must be already playing your sound files in order for this option to be offered.

Please note that all (any) video selection(s) will be automatically de-selected (there would be no point in 
displaying them as you would not be able to see them on the Graphics Viewer screen!).

If a video is currently on display when you take this option, it will immediately be stopped.

Also, ‘Auto Play’ mode will be forced to ON if you choose to leave sound playing (this is to allow a sort of
"Slide Show" of sound whilst you are viewing graphics).

Please bear in mind that some systems may not take too kindly to playing WAV and MID files whilst trying
to display graphics or search drives etc. (you will just have to try it on your system and see how it goes).

Also note that MidWavi Pro will prevent you from attempting to play audio CD simultaneously with
MID and/or WAV sound and video files.

See also MidWavi Pro Play Lists.
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Search Drive

Search Drive
This is an extremely powerful option that is available to you in both sound/video and graphic modes.

It allows you to search any drive in your system (including CD and mapped network drives) and will 
automatically build a list of any target file(s) found.

(Please note that one of the few limitations of the un-registered version is that you cannot conduct
a disk search "Search Drive" option for MED (*.med), MPEG (*.mp2, *.mp3 or *.mpg) files, or 
graphic files of type “FIF”. See "Non Registered version restrictions" in ReadMe.Txt).

Target file(s) means:

In graphic display mode…

Find all *.BMP files on the disk

Find all *.FIF files on the disk

Find all *.ICO files on the disk

Find all *.WMF files on the disk

Find all *.JPG files on the disk

Find ALL of the above types on the disk

In sound/video play mode…

Find all *.AU files on the disk

Find all *.AVI files on the disk

Find all *.MED files on the disk

Find all *.MID files on the disk

Find all *.MP2 & *.MP3 (MPEG sound) files on the disk

Find all *.MPG (MPEG video) files on the disk

Find all *.MOV files on the disk

Find all *.WAV files on the disk

Find ALL of the above types on the disk

Please note that a search for *.dat (VideoCD) couldn't be included because it's a common file extension 
(i.e. is not unique to VideoCD MPEG video)...maybe checking will be added in another version, but this 
will slow the search down, so maybe not!).



If you wish to play a VideoCD movie, you should use the Select Sound & Video option, then select 
the *.dat option from the ‘Files of type’ drop down list and “pilot” yourself to the required 
directory on the CD.

In graphic display mode, the buttons caption changes to reflect the type of search you are about to 
undertake.

For example, if you were searching all of drive C: for (say) BMP files, the buttons caption    becomes ‘Find
all BMP’s on drive C:’

Up to 24,000 file names are supported with this option!

What this means is that you have the opportunity to setup a totally automatic search which manually 
could take a very long time indeed (during a test, 24,000 *.WMF were located on a CD disk in approx. 15 
seconds! This figure will of course vary depending on your system components).

It should also be noted that at the extremes of file name support, your system is almost bound to slow 
down (particularly in the ‘Re-size to fill screen’ option) during the display process. This is normal.
 
To set your required search pattern, first choose the target drive from the drop down drive list box (this list 
will include all legitimate drives on your system including any mapped network drives).

Then, set the file type from the drop down list box of supported file types:

For sound/video: AU, AVI, MED, MID, MPG (MPEG Video), MPEG (MP2 & MP3), MOV, WAV or ALL of 
these

For graphics: BMP, FIF, ICO, WMF, JPG or ALL of these

Please note that a search for *.dat (VideoCD) couldn't be included because it's a common file extension 
(i.e. is not unique to VideoCD MPEG video)...maybe checking will be added in another version, but this 
will slow the search down, so maybe not!).

If you wish to play a VideoCD movie, you should use the Select Sound & Video option, then select 
the *.dat option from the ‘Files of type’ drop down list and “pilot” yourself to the required 
directory on the CD.

Finally, for sound/video file searching, click ‘Search Drive’ or for graphic file searching (and let us say 
that you wish to find all supported graphic file types on D: drive) click ‘Find ALL on drive D:’

At any time during the search, you may hit the escape (Esc) key to abort the search but be aware 
that Esc may not appear to take immediate effect (just wait a while, it will eventually kick in).

When the search is completed, MidWavi Pro’s file list box will contain all files found matching the search 
criteria (complete with file path details).

Now see:

For sound/video files: Playing Selected Sound & Video Files.

For graphic files: Displaying Selected Graphic Files 





FIF Graphic Files

MidWavi Pro supports the excellent FIF (Fractal Image Format) graphic format from Iterated Systems Inc.

For those of you not yet familiar with this format, Iterated Systems Inc “Fractal Image Format” can offer 
amazing compression on graphics with little or no noticeable loss in quality...you must see this for 
yourself!

Further details can be obtained from: http://www.altamira-group.com

In order to offer this new functionality, MidWavi Pro requires an external library file called DECO_32.DLL 
which must be placed in the same directory as MidWavi.Exe and MidWavi.Hlp.



MPEG Sound

Credits due (and thanks go) to…

Fraunhofer and THOMSON multimedia.

MPEG Layer-3 audio compression technology is licensed by Fraunhofer and THOMSON 
multimedia.

TSoft Ltd are making no extra charge for MPEG capability (i.e. the registered price of MidWavi Pro 
remains unaltered – see “Registration details”) thus retaining the spirit of “freeware” MPEG.

MidWavi Pro supports Layer 2 (*.mp2) and Layer 3 (*.mp3) sound files.

MPEG Video

MidWavi Pro supports *.mpg and *.dat video files.

MOV Video

MOV video/sound files are now supported (inc full screen) but keep in mind that not all MOV files 
are created equal. If the Windows Media Player (version 6.x or later) cannot display a MOV video, 
then chances are neither will MidWavi Pro.

MPEG and MOV sound and video problems are dealt with in the FAQ (Frequently Asked 
Questions) text file that accompanies MidWavi Pro.



Controlling Fonts & Colours

Normal      Bold      Default      Min      Max      -      +      Colour control:
You may control the look and colour of the font used to display file names in the MidWavi Pro file list box 
(in both Sound/Video and Graphic windows) by use of the row of buttons and colour box positioned 
immediately below the file list box.

Button Action

Normal Make font non bold

Bold Make font bold

Default Reset to point size 10 bold (Blue)

Min Reset to point size 8 not bold

Max Reset to point size 24 bold

- (minus) Reduce point size of font by a factor of one step (e.g. 24, 18 etc.)

+ (plus) Increase point size of font by a factor of one step (e.g. 10, 12 etc.)

The Colour Control:
This is a drop down list box which will display sixteen possible choices of font colour (Blue is the default 
for MidWavi Pro).

(Please note that in MidWavi Pro Graphics Viewer, this option is only available in TV Look).

The current font colour will displayed on a white background to the left of the down arrow box that you 
need to click in order to access the colour selections.

If you wish to change the colour of the font, click the down arrow then click on your desired colour (be 
careful, one of the standard colours is the same as the list box background so obviously, if you choose 
this, you will no longer be able to see the file names!!).

You may also provide a custom font colour and to do this you need to click on the LAST item in the 
drop down list. This will yield a palette of colours for you to select from (or you can drag the cursor 
around in the multi colour box until you achieve the desired effect). Click ‘OK’ when done (or ‘Cancel’ to 
abort).

You may create just one preserveable custom font colour.

Any current custom font colour is automatically preserved by MidWavi Pro on exit but you need to be 
aware that should you ever return to the ‘Default’ option or choose one of the sixteen standard colours, 
your custom font colour will be lost the next time you run MidWavi Pro.



Displaying Selected Graphic Files

Displaying Selected Graphic Files
Once you have selected your files (see also Graphics Viewer and Clipboard), you will have a list of them 
in the MidWavi Pro file list box.

A feature called sub selection (a kind of secondary file selection option) is now available to you.

Once you have made your initial selection (i.e. the file list box has been populated), you will notice that 
every single file name now has its own checkbox beside it (they will all be ticked when first selected). See 
also 'Sub Select'.

This means that by clicking in the checkbox area of the file name, you can toggle that individual 
selection ON/OFF (i.e. ticked/checked - not ticked/unchecked).

Let us say that your initial selection produced ten file names. If you were to then uncheck file names that 
appeared in the order 2, 4, 8 and 10 and then opted for 'Slide Show', file names 1,3,5,6,7 and 9 only will 
be displayed.

It should be remembered that whilst, normally, WMF (vector) and FIF (Fractal) type graphics take 
well to being shrunk or expanded, BMP (bitmap) and JPG graphics generally do not.

You can also run endless Loop and Random graphic shows (the ultimate screen saver!). 

Random Play mode:

Either single right mouse click ‘Display’ or take "Random ON/OFF" options from the ‘Tools’ menu.

Please be aware of the following limitations:

MidWavi Pro supports up to 24,000 filenames when using the powerful "Disk Search" option.
 
The maximum filenames for random display is 24,000 (which is the maximum allowed anyway).

Random mode will play "for ever" (well, click ‘Stop’ to end it).

MidWavi Pro will always start up in "Random Play OFF" mode but any "toggles" (changes of mode) will 
remain on a per session basis unless MidWavi Pro senses bad logic (i.e. trying to play one file 
randomly!!!).

Endless Loop (in sequential order):

You can also run a continuous graphics show (i.e. your chosen graphics can be displayed repeatedly 
such that when the last one in a selection is displayed the cycle begins again at the first).

You get to this feature from the ‘Tools’ menu or by single right mouse clicking the ‘Slide Show’ 
checkbox - this toggles between ‘Slide Show’ and ‘Loop Show’.

The ‘Tools’ menu option ‘Loop Play OFF’ toggles to ‘Loop Play ON (Esc or Stop to end)’ and back 
each time you click on it.

Clearly, with ‘Loop Play ON (Esc or Stop to end)’ set (or ‘Loop Play’), you have your endless graphics 
show.

Use the checkbox ‘Slide/Loop Show’ as an indicator of the mode you are in.



MidWavi Pro will always start up in ‘Loop Play OFF’ mode but any "toggles" (changes of mode) will 
remain on a per session basis.

As may be apparent, if you combine the sound and graphics loops, you could have a screen saver 
playing your selected pictures (full screen) and sounds endlessly (and/or randomly).

MidWavi Pro now "learns" about “bad” graphic files it cannot load, and self deletes the offending file(s). 
Note, this does not mean it actually deletes the file(s), it merely unchecks (unticks) them from the ListBox.
This should mean that when running in Slide-Loop-Random, you will only see a message once saying 
"Problem loading xxxx filename" etc.

There are several modes for displaying graphics and these are as follows:

TV Look
With the ‘TV Look’ checkbox ticked (checked), the graphics will be contained (**shrunk or expanded) 
within the area that was occupied by the file list box.

(**Note: Icon files .ICO are displayed at their original size only).

In this mode, the radio button ‘Allow original size’ is automatically set whilst ‘Compact’ mode (see 
more below) is not allowed.

All controls (Display, Next, Previous etc.) are visible/usable in this mode.

With the ‘TV Look’ checkbox not ticked (un-checked), the following applies:

Allow original size:
If this radio button is clicked, the graphic will be displayed at its original size (centered on-screen). This is 
often the best mode for BMP and JPG files.

Re-size to fit window:
If this radio button is clicked, the graphic will be stretched to fill the entire area occupied by MidWavi Pro’s
window (.ICO files will remain at original size, but the background will fill the entire MidWavi Pro window 
and thus all controls will be obscured).

Re-size to fill screen:
If this radio button is clicked, the graphic will be stretched to fill the entire screen and automatically 
adjusted for your screens resolution e.g. 640 x 480, 800 x 600 etc.    (.ICO files will remain at original size,
but the background will fill the entire screen and thus all controls will be obscured). 

Controlling the display in the above three modes:

In non "TV" graphic modes (i.e. no controls are visible), you may "single right mouse" click to bring up a 
popup menu that offers Next-Previous-Stop-File Detail etc. If you are in "Play & Display" mode, the 
current sound filename or CD track playing is also displayed.

If you right click outside the graphic, you'll be on the Windows desktop (except in full screen mode) so 
take care!

Also when NOT in "TV Look", you have an option to turn the "Slide Show" mode ON (if its already on, the 
option is disabled - greyed out). Again, you get to this option from the single right mouse popup menu.

Ensure that the mouse cursor is positioned within the graphic itself whilst you are clicking.



Compact:
If this checkbox is ticked (only available when ‘TV Look’ is not ticked), the whole MidWavi Pro window 
reduces to the size of the button control panel (i.e. the file list box etc. is no longer visible).

This mode is useful if you wish to have more of your desktop visible whilst running MidWavi Pro in graphic
display mode.

All comments above regarding re-sizing apply to this mode except that of course in the ‘Re-size to fit 
window’ option, the area used will be much reduced (i.e. graphic will only occupy the area containing the 
control buttons).

If this checkbox is un-checked (no longer ticked), the whole window will be automatically re-sized to 
normal and ‘TV Look’ set as the default.

Once you have selected a display mode, you may now either:

· Highlight a file name (single left click), then double left click it to display that file

· Highlight a file name (single left click), then click the ‘Display’ button to display that file

· Click the checkbox ‘Slide Show’ so that it is ticked (checked) and all the selected files will be
automatically displayed in sequence from the highlighted file onwards (see more below for
setting Slide Show delay)

At any time in ‘TV Look’ you may click the ‘Next’ or ‘Previous’ buttons to move forwards or backwards 
through the file list.

If the display mode precludes the use of ‘Next’ or ‘Previous’ buttons, single clicking the left 
mouse button will move to the previous selected graphic or single clicking the right mouse button
will move to the next selected graphic and Esc (escape key) will abort.

Ensure that the mouse cursor is positioned within the graphic itself whilst you are clicking.

Sub Select
This button will yield a small box offering the chance to filter your original selections even further.

Let us say that you have taken the 'Search Drive' option (which will automatically select all files for 
displaying) but you only wish to display BMP and WMF files. If you click the checkboxes marked BMP and
WMF, your selections will automatically be made for you from the original list meaning that only these file 
types will be selected for playing from the list.

Also, you will notice a number beside each checkbox that signifies how many of that type were found (i.e. 
if there were 30 *.JPG files found then the number 30 will be next to the JPG checkbox etc. etc.).

Search Result
This option allows you to search through the list of files that you, or search drive, have selected.

The search will always commence at the currently highlighted filename.

You can isolate the search to the filename only part of the full pathname by prefixing your search with the 
asterisk (*) character.

Suppose you want to know if you have a graphic file with (say) the word "tiger" (without the speech marks
of course) in it, then your search pattern will be *tiger. 



If you want to see if there are any more "tiger" files, take this option again, and the last item searched for 
will be offered as the default to search for again (you can of course overtype this for a new search).

If a match is found, the file will be automatically highlighted for you ready for play.

An example:

If you wished to locate only filenames containing the characters (say) "bear" (without the speech marks of
course), you would enter *bear as your search pattern.

If you leave out the * character, the entire pathname is searched meaning that any directories (Folders) 
containing "bear" would also be returned.

Be aware that the search will always commence from the currently highlighted filename forwards, so 
keep this in mind if you are near the end of a list.

A message box will popup if there are no (or no more) matches for the search.

Tip: The quickest way to go to the top of a file list is to click anyway in the list, then hit the 'Home' key.

Tip: The quickest way to go to the bottom of a file list is to click anyway in the list, then hit the 'End' key.

Keyboard selection:
Ensure that the file list box has the focus (i.e. that this is the area of your screen where input is accepted).
You do this by either left clicking anywhere in the file list box or hitting the ‘Tab’ key until a dotted line 
appears around the currently highlighted file name.

Use of the ‘Home’ and ‘End’ keys is supported to pilot yourself to the top of a file list (‘Home’) or bottom 
of a file list (‘End’). You may also use the up/down cursor keys to pilot around the file list. 

Once the desired file name is highlighted, you can hit the ‘Enter’ key to commence display.

Slide Show:
If this checkbox is ticked, you can produce an automatic delayed sequential display of all your selected 
graphic files. When single right moused clicked, this toggles between ‘Slide Show’ and ‘Loop Show’ 
(see above for details on Loop Show).

The delay per second between displays of the graphic files defaults to 4 seconds but you can change this 
with the control at the bottom of the screen (‘Delay per second for Slide Show (1-20)’).

You can choose anywhere between 1 and 20 seconds delay by either:

· Dragging the bar adjacent to the box containing the current number of seconds

· Typing in a value between 1 and 20 in the box

In ‘TV Look’, because this control is visible/usable, you can change the delay ‘on the fly’ (i.e. whilst a 
slide show is in progress).

Note: because this control is not visible/usable in ‘Compact’ mode, you will need to set it to your 
requirements before entering ‘Compact’ mode, however, please also note that the first time you enter 
‘Graphics Viewer’ mode, only the control buttons are visible (i.e. there is no slide show delay control 
visible).

All possible/relevant controls (including ‘Delay per second for Slide Show (1-20)’) are made 



visible/usable once your first file selection has been made.

To stop a slide show, in ‘TV Look’, hit the ‘Stop’ button and in all other modes hit the escape key (‘Esc’).

File size, date and time and full path and file name details:
In ‘TV Look’, to obtain byte size and date details of the currently highlighted file or file being displayed, 
you may single right click either anywhere in the file list box area, anywhere in the graphic itself or 
anywhere on the MidWavi Pro window (suggest bottom right corner).

In addition, if the graphic is actually on display when you single right click in it (‘TV Look’ only), the 
height and width (in pixels) of the graphic is also shown.

If the files were located by way of the disk search option, the complete path and filename is displayed.

If the files were located by way of self-selection (i.e. you nominated and picked files from a    directory), 
only the filename is displayed (obviously, all the files will be in the directory that you selected!).

In any other mode, you will have to abort (Esc key) in order to gain access to the file list box or window 
before obtaining the file details as above.

If no file time is shown, this means the file was created at midnight (00:00:00).

Print:
MidWavi Pro allows you to send BMP, FIF, JPG and WMF graphic files to the Printer.

A button called "Print" has been provided for this purpose (and you can also double left click within a 
displayed graphic to summon the print).

Please note the following:

· You can only print graphics when in "TV Look".

· The file must be currently on display.

· Printing of Icons is not supported.

· You cannot print if a "Slide Show" is running.

MidWavi Pro will either prohibit use or issue suitable warnings if any of the above criteria are not met.

In view of the fact that printing is (in the main) handled by your printer driver, it is urged that you ensure 
you have the latest version of the driver (same goes for the video driver!).

MidWavi Pro will offer you options re setting up your printer and the size of the printout (including "Fit To 
Page") and whether or not you want filename details printing.

You can also opt to have the printout centered on the page (“Centre Print On Page”).

MidWavi Pro offers a pre-print screen preview that "shadows" the current printer setting (i.e. Portrait or 
Landscape mode) and page size. You are offered the chance to setup your Printer with whatever options 
are available to you before you make the actual print (click the "Printer Setup" button to setup your 
choices).

In “Preview” mode, any key or mouse click takes you back out.



I leave you to experiment with these settings, but as rule of thumb, it is probably well advised not to go 
more than one or two up on MidWavi Pro's suggested default.

An example:

When you have selected your file for printing, there are eight possible output sizes:

· zoom x2
· zoom x4
· zoom x6
· zoom x8
· zoom x10
· zoom x12
· "Fit To Page"
· "Original"

and MidWavi Pro will "select" what is considered to be the most suitable. If (say) zoom x4 was the default,
then zoom x8 is probably as high as you should go (use the screen preview to check).

However, bear in mind that you cannot always rely on the screen preview (what might look OK on screen 
could have too little information contained in it for the Printer).

Also, observe the effects of combining “Centre Print On Page” and “Fit To Page”.

Keep an eye on the reported graphic height and width as these can give you a clue as to whether a file 
will successfully "zoom" (e.g. a width and height of (say) 80 are unlikely to zoom too well). 

A sign that the "zoom" factor is too high will be that the printer merely form feeds the paper with no output 
on it or that all you get is a black mess!

If your printer driver supports it, you can opt for Landscape or Portrait output, Best Mode, Normal Mode, 
EconoMode, type of paper, number of copies and so on (click the "Printer Setup" button to setup your 
choices).

Once again, it is stressed that much will depend on the quality (or not) of your printer driver and in this 
respect all bets are off regarding the output you will obtain.

Normal ~ Bold ~ Default ~ Min ~ Max ~ - ~ + ~ Colour control:
See Controlling Fonts & Colours.

Refresh:
During tests in ‘TV Look’, it was found that under certain rare conditions, ‘stray’ graphics can stay on 
screen after the display has moved on to another graphic (i.e. parts of a previous graphic are still visible 
on a new graphic).

You should (may) never see this as its almost certainly a peculiarity of the video driver (in one case, the 
problem could always be reproduced at 800 x 600 but went away in 640 x 480).

However, if you do ever get this problem, clicking the ‘Refresh’ button will cure it.

See also Clipboard



MidWavi Pro Play Lists

MidWavi Pro Play (and Display) Lists

Please note that whilst all versions of MidWavi Pro 2.58 and on will build and save Play Lists/ Display 
Lists, only the Registered versions will actually play/display them.

Also note that one of the few limitations of the un-registered version is that you cannot conduct a disk 
search "Search Drive" option for MED (*.med), MPEG (*.mp2, *.mp3 or *.mpg) files, or graphic files of 
type “FIF”. See "Non Registered version restrictions" in ReadMe.Txt.

What are Play Lists/Display Lists?

Play Lists/Display Lists enable you to preserve the contents of your file list box to a data file which, at a 
later stage, can be loaded back in.

In short, if it’s in your file list and it’s selected (ticked), it can be saved for later use.

Play Lists are for sound and video files.

Display Lists are for graphic files.

How to build a Play List (differences for Display Lists are shown)

This example makes use of the MidWavi Pro Search Drive and Sub Select options to build a Play List 
(i.e. sound and video).

Go to the Sound And Video Player module.

Use MidWavi Pro’s powerful Search Drive option on (say) drive C: to find ALL files.

Assuming that you have a variety of sound and video files (.avi, .mpg, .mp3, .mp2, .mid and .wav) on 
drive C, your list box will now be populated with filenames.

(Un-registered versions will not of course "find" any MPEG files during the "Search Drive" option).

Take the File menu option and then select Save Play List.

Once the Save dialog box appears, pilot yourself to a suitable directory where you will store your play lists
(suggest you create a directory called "MidWavi Pro Play Lists"). 

In the File Name box, enter a suitable filename (because you are about to store all the sound and video 
clips that are on your C: drive, suggest you call it "All Sound & Video On C"). If you wish to use a period 
(".") as part of the name, see Use of Filenames within MidWavi Pro below.

Do not add a file extension because MidWavi Pro will add its own for you (.MPL).

(For Display Lists, the file extension automatically added is .MDL).

Click the Save button, and you will be advised if the data was successfully saved.

You now have a Play List called "All Sound & Video On C.MPL" that contains details of all sound and 



video clips on your C: drive.

Now, assuming that you have some, lets say that you want to create a Play List that will only play all the 
AVI video files on your C: drive.

Take the Sub Select option.

Tick the No Files Selected box then tick the AVI box and click OK

Again, take the File menu option and then select Save Play List.

This time in the File Name box, enter a suitable filename for all the AVI video clips that are on your C: 
drive, suggest you call it "All AVI Video On C").

Click the Save button, and you will be advised if the data was successfully saved.

You now have two Play Lists called:

"All Sound & Video On C.MPL" and "All AVI Video On C.MPL".

Repeat the process as necessary.

You are of course free to "roll your own" Play Lists by selecting (ticking/un-ticking) only those files that you
wish to preserve in the list box and saving that selection to your chosen Play List filename.

It will be apparent that only filenames that are selected (ticked) will be saved in a Play List/Display 
List.

Once a Play List or Display List is created, you can over-write it by double clicking on it (a suitable 
warning will be issued).

You can also edit (using NotePad or WordPad etc.) the Play List/Display List files to manually add or 
delete file details but remember the file MUST be saved as a plain text (ASCII) file.

If you wish to create a Play List or Display List from scratch (using a text editor rather than let MidWavi 
Pro do it for you), the only four provisions are:

· It must be a plain text (ASCII) file

· For Play Lists, the first line must read "MidWavi Pro Play List" (without the speech marks)

For Display Lists, the first line must read “MidWavi Pro Display List” (without the speech marks)

· It should have a filename extension of either ".MPL" (sound and video) or ".MDL" for graphics.

· The full path and filename must be included on each line for each file you wish to play 

You can easily display a MidWavi Pro created Play List/Display List file using any standard ASCII editor 
(e.g. WordPad or NotePad in "text" mode) to see the desired format.

Any files created outside MidWavi Pro that do not have the file extension ".MPL" (or ".MDL") but conform 
to the above criteria will be "playable", but you will have to type in the full name when selecting a Play 
List/Display List (MidWavi Pro only "looks" for *.mpl or *.mdl type filenames).



Use of Filenames within MidWavi Pro

When choosing a Play List name to save from within MidWavi Pro, please observe the following:

· Any file extension other than '.MPL' will be forced to '.MPL'.

For Display Lists (graphics), the extension will be forced to ‘.MDL’.

· The last dot in any filename will be regarded as the start of the filename extension.

Some examples:

Filename: "Test" will be saved as "Test.MPL"

Filename: "Test.DAT" will be saved as "Test.MPL"

Filename: "Test Data Version 2.56" will be saved as "Test Data Version 2.MPL"

Filename: "Test Data Version 2.56 Latest" will be saves as "Test Data Version 2.56 Latest.MPL"

etc. etc.

How to load a Play List
Go to the Sound & Video Player module.

To play back your Play Lists, either go to the Tools menu option and click Play List OFF to turn Play List
ON (this toggles ON/OFF each time you click it), or single right mouse click the Select Sound & Video 
button.

Either way, the Select Sound & Video button becomes Select Play List (again, this toggles in step with 
the above instruction).

Click the Select Play List button and a file load selection box will appear.

Pilot yourself to your Play List directory, and, if you have followed the above example, you should now 
see the two Play Lists ("All Sound & Video On C.MPL" and "All AVI Video On C.MPL").

You can only select one Play List at a time so double click either one (or single click to highlight then click 
the Open button).

How to load a Display List
Go to the Graphics Viewer module.

To play back your Display Lists, either go to the Tools menu option and click Display List OFF to turn 
Display List ON (this toggles ON/OFF each time you click it), or single right mouse click the Select 
Files For Display button.

Either way, the Select Files For Display button becomes Select Display List (again, this toggles in step 
with the above instruction).

Click the Select Display List button and a file load selection box will appear.



Pilot yourself to your Display List directory.
 
You can only select one Display List at a time so double click either one (or single click to highlight then 
click the Open button).

How to play or display a Play List or Display List
Your file list box will now be populated with your selected Play List/Display List and you can now use this 
as normal (see Playing Selected Sound & Video Files or Displaying Selected Graphic Files).

An additional feature now means that when you single right mouse click in the file list box (or on a 
graphic) to get file details, if a Play List or Display List is in use, its name is now also displayed along with 
the rest of the file detail. See File size, date and time and full path and file name details in Playing 
Selected Sound And Video Files etc.

Obviously, to get back to the standard Select Sound & Video or Select Files For Display options, toggle
the button as per the above instructions.

Again, in a statement of the obvious, if you create a Play List or Display List based on removable media 
(CD ROM etc), ensure that you have the correct media installed to match the Play List.

The worst that will happen if not is that MidWavi Pro will report that it cannot play the file(s).

Please note that whilst all versions of MidWavi Pro 2.58 and on will build and save Play Lists/ Display 
Lists, only the Registered versions will actually play/display them.

Also note that one of the few limitations of the un-registered version is that you cannot conduct a disk 
search "Search Drive" option for MED (*.med), MPEG (*.mp2, *.mp3 or *.mpg) files, or graphic files of 
type “FIF”. See "Non Registered version restrictions" in ReadMe.Txt.



Clipboard

MidWavi Pro supports the Windows Clipboard as follows:

Whilst using the Graphics Viewer, at any time a graphic is on display you can use the standard 
Windows keys Ctl + C (that’s hold down the Control Key and then the C Key together) to send the 
graphic currently on display to the Clipboard.

Whatever the mode (Full Screen etc.), the graphic will be placed at its original size onto the Clipboard.

If you are in TV Look, you have a Menu option called Edit, off of which is Copy – Ctl+C. This has exactly 
the same effect as hitting Ctl+C.

In modes where you cannot see the Menu (Full Screen etc.), if you single right mouse click anywhere 
within the graphic on display, an option to Copy to Clipboard is provided on the popup Menu and, again, 
this has exactly the same effect as hitting Ctl+C.
 
When you exit MidWavi Pro, if you have used the Clipboard you are given the opportunity of deleting the 
contents. If you no longer need the contents of the Clipboard, it’s as well to clear them as this will free up 
memory.

There is also an option on the ‘Edit’ menu to “bring up” the Windows Clipboard Viewer called ‘Display 
Clipboard Viewer’.

This can be handy to check what is on the Clipboard or to see its contents being changed in real time.

If you do not have the Clipboard Viewer installed, a suitable message is given (you can add the viewer by 
way of the "Windows Setup" tab on the "Add/Remove Programs" area of the Control Panel).



Registration details
MidWavi Pro is deemed to be an "electronic" sale in as much as you already have the software (and can 
download the latest version at any time from the web site: www.midwavi.com).

This saves on distribution costs and helps to keep the price down.

For this reason, it is essential that you have an email address, as this is the only way that you can receive
your Registration Keys.

Price Reduction!
Full registration of MidWavi Pro costs only:

£12.00 – twelve pounds sterling or

$18.00 – eighteen dollars.

Please note that it may not be possible to sustain this price 
on future versions.

____________________________________________________________

You can buy MidWavi Pro on-line from all the MidWavi Pro web sites:

www.midwavi.com

www.midwavi.co.uk

www.tsimpson.demon.co.uk

See the “Buy now” options at the bottom of the Home page.

____________________________________________________________

For voice telephone (or fax) credit card orders 
(Visa~Mastercard~Switch~Delta) contact:

Electronic Universe:

+44 1933-271500
 (UK 01933-271500)

BE SURE TO INCLUDE:



1. Your email address (vital!) and full postal address

2. Your first and last names (so that your copy can be personalised)

3. The version of MidWavi/MidWavi Pro that you are currently using

You will then receive email containing your Registration Keys and details on how to personalise 
your own copy of MidWavi Pro (and if applicable, you can download the very latest version from 
the web site – www.midwavi.com).

For on-line registrations:

You may pay by cash, cheque or secured credit card…

For orders in the USA (or anywhere) contact:

Atlantic Coast Soft Shop
From the "Help" menu in MidWavi Pro, click on "Register MidWavi Pro" and follow the prompts.

Or, you can go directly to the order site at:

www.soft-shop.com/cgi-bin/order.html?simpsont

BE SURE TO INCLUDE:

1. Your email address (vital!) and full postal address

2. Your first and last names (so that your copy can be personalised)

3. The version of MidWavi/MidWavi Pro that you are currently using

You will then receive email containing your Registration Keys and details on how to personalise 
your own copy of MidWavi Pro (and if applicable, you can download the very latest version from 
the web site - www.midwavi.com).

For orders in the USA (or anywhere), contact Kagi as follows:

Either run the supplied program called REGISTER.EXE and follow the prompts.

Or, from the "Help" menu in MidWavi Pro, click on "Register MidWavi Pro" and follow the prompts.

BE SURE TO INCLUDE:

1. Your email address (vital!) and full postal address

2. Your first and last names (so that your copy can be personalised)



3. The version of MidWavi/MidWavi Pro that you are currently using

You will then receive email containing your Registration Keys and details on how to personalise 
your own copy of MidWavi Pro (and if applicable, you can download the very latest version from 
the web site - www.midwavi.com).

For orders in the UK & Europe (or anywhere), contact
UK ShareReg as follows:

From the "Help" menu in MidWavi Pro, click on "Register MidWavi Pro" and follow the prompts.

Or, you can go directly to the order site at:

www.uksharereg.com/midwavi.html

BE SURE TO INCLUDE:

1. Your email address (vital!) and full postal address

2. Your first and last names (so that your copy can be personalised)

3. The version of MidWavi/MidWavi Pro that you are currently using

You will then receive email containing your Registration Keys and details on how to personalise 
your own copy of MidWavi Pro (and if applicable, you can download the very latest version from 
the web site - www.midwavi.com).

You can contact TSoft Ltd direct at:

email: support@midwavi.com

web site: www.midwavi.com or www.midwavi.co.uk

Upgrades are planned for MidWavi Pro, and as a registered user, you will be untitled to free updates or 
preferential prices on any future version(s).



MED Sound

MED sound files are produced by OctaMED from RBF Software.

You can find full OctaMED details at www.octamed.co.uk

There are some limitations that you should be aware of with MED files and MidWavi Pro.

First off, this sound format was originally written for the Commodore Amiga computer which as you 
probably know, used completely different hardware (including the CPU) and software than that of the PC.

Because MED sound files were primarily intended to perform in an endless loop of sound, this poses a 
problem with the MidWavi Pro Auto Play feature (i.e. how do we move onto the next sound file in a list).

In an attempt to get around this, MidWavi Pro has been equipped with an option (see menu option Tools -
Configure MED playing) called Determine MED play end which, by the way,    defaults to ON (ticked).

With this option OFF however, the default endless loop play will occur and you will have to either hit Next,
Previous or the Stop button depending on your intention.

With this option active (ON), MidWavi Pro will attempt to provide a "Stop" point for the currently playing 
MED and cease playing at what is deemed to be the end of the sound then move on to the next selection 
(assuming Auto Play to be ON of course).

However, this will not always work because of:

1. Timing problems
2. MED files with a software stop (end) in them

Number two above is interesting in as much as it has always been possible for authors to impose an 
ending in their MED's (rather than the default endless loop), but if this is the case, there is no official way 
at present to know when the MED has stopped!

Various methods have been attempted to get around this behaviour for this release of MidWavi Pro, but 
none were deemed satisfactory...so, what to do...

In ALL cases, if you find a MED is either "stuck" (as in 2. above) or is endlessly looping, either hit Next, 
Previous or the Stop button depending on your intention.

Another known problem is that old Amiga created MED files ported across to the PC may well play "as is",
but the reported total play time and update play time may be inaccurate.

Also, if you wish to Play (or Auto Play) MED files whilst MidWavi Pro is minimised, do not minimise 
MidWavi Pro by double clicking its icon in the task bar (bottom of screen)...use the actual Minimise button 
on MidWavi Pro's window (NB although the file(s) will be playing, you will not hear any sound if you 
play MED files minimised in Windows NT4).

It's worth mentioning here that all the other options on the Tools - Configure MED playing menu option 
have to do with possible timing problems and I can do no better than to quote from some original 
OctaMED documentation:

"Because med music is all done in real-time, you may encounter performance problems during playback 
and the operation may become unacceptably slow causing hesitations or 'glitches'.

The problems are influenced by your computer's specification and, (unfortunately), with the O/S 



(operating system).

Try switching on the 'Solid Mode' which reduces multitasking problems, but at the same time, can also 
make the playback of the music respond less quickly when playing notes.

If there is still a playback problem, try switching on "Increase Update Interval"

If, after trying the above, playback still appears 'glitchy' you could also try closing down any programs that
are running which are not needed as this will free up some processor time. ( one of the main causes of 
'glitches'    )

It has also been noted that some of the med mods authored with the old Amiga version of OctaMED have
timing problems with the new PC version and this is because the Amiga version used the older IRQ timing
instead of the more accurate BPM timing. 

The only solution to this is to load the problem med mod back into the new Windows version and simply 
alter it's timing to BPM and re-save it. 99% of the time they will then work perfectly."

You can find full OctaMED details at www.octamed.co.uk






